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Introduction

As an integral part of the Ford Guest Experience, the Digital Sales Guide (DSG) is a tool built for Sales
Consultants at Ford dealerships to improve the Guests’ experiences and Ultimately increase sales.
This User Manual has been written to aid Sales Consultants (and other users) learn to use and take

advantage of the many features the DSG is capable of.

The DSG has been designed to be intuitive to use, beautiful to look at, and powerful at the same time.
It is an iPad application used by Sales Consultants (SCs) at Ford dealerships across Asia Pacific to
improve the sales journey by making it more convenient for Guests to explore a nameplate and

configure a model that is most suitable for them.

This manual will guide you through all the screens and functions to help you provide the very best

experience for your Guest.

' Note: all images used was taken before the development is finalized; thus for reference only
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Glossary

( Ford_

The table below includes terms and acronyms widely used throughout the DSG.

Term / acronym

DSG

Showroom

Explore

Smart Drive Audio

Configure

Model Compare

Explanation

Digital Sales Guide - the iPad application that Sales Consultants utilise to

interact with Guests in dealerships.

The vehicle selection page broken down in Cars, SUVs, MPVs, Performance

Cars, based on what is available on the website.

The selected vehicle exploration page, allowing Guests to deep dive and

explore product features of selected vehicles.

The Smart Drive Audio is part of the Smart Drive which contains a list of audio

tracks to help Guests to better understand the key features of the vehicle.

The vehicle configurator page, allowing Guests to customize their selected

vehicle down to the accessory level.

The model compare feature allows users to compare different variants of the

same Ford nameplate.
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( Ford_

Guest Souvenir The Guest Souvenir feature allows the sales consultant to use the iPad camera
to capture relevant moments to personalise and share with the Guest to
remind them of the excellent service they received and entice them to come

back for a purchase.

CCcT Competitive Comparison Tool for Sales Consultants to compare Ford vehicles

against available competitors in the app.
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Update Process

Ongoing maintenance, feature enhancements, and feature introductions will be provided via updates

to ensure continuous improvement of the DSG.

Updates can be categorized into two major type (Content Updates & App Updates):

Content Updates

The DSG will automatically check for content updates upon application launch. These updates

include:

1. Vehicle assets for the Showroom, Explore, and Configure sections.
2. Information about features and models (prices, descriptions, images, videos).

App Updates

When an App update becomes available, you will receive a pop-Up message upon application launch

notifying you of an Update and indicating a window to complete the update in. These updates include:

New features

e Feature enhancements

Bug fixes

Optimisations
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Login / Logout

Login
Before you login, you need to ensure:

¢ Device requirments: The New DSG Application is Recommended for best view: In iPad / Android
Tablet

e |talsoworks iOS and Android Mobile devices.

® iOS 15 and above / Android 10 and above

e Ensure Device is connected to the internet via wifi or cellular data (3G / 4G).

e You have your SPS ID (Ford Email ID) and password ready (if you don’t have an SPS ID
(Ford Email ID), please ask your dealership manager to contact the local IT team to

create one for you).

Note:
1. Ensureyour SPS ID is valid and active.
2. Toreset the password of your SPS ID, please navigate to:

https.//www.faust.idp.ford.com/signin from your computer not

IPad/Tablet/Mobile
3. Toreset the password of a QA SPS ID, please navigate to:

https://wwwaqa.faust.idp.ford.com/signin from your computer not

IPad/Tablet/Mobile
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How to Login
e Tap on DSG application on your device to launch the DSG.
e Tapthe Enter Application at the bottom to login.

Note: This will automatically redirect you to a Ford login page in a built-in web browser.

Login screen Enter app image

e Input your SPS ID (Ford Email ID )and password and tap login.
Note: Once your SPS ID and password have been authenticated by Ford Azure AD you will then return

to the DSG User Interface.

Ford Guest Experience

DSG APP

Enter Application
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T-DSG: User ID and/or password invalid.

Sign in

Forgot Your Pas:

Capyright ©2025 Ford Motor Company - Authentication Services

e Access denied due to incorrect SPS ID credentials. This could be due to the following reasons:

o Incorrect SPS ID or password, country or dealership.

o Incorrect SPSID job role.

If any of the above errors occur you may need to contact your dealership manager to help resolve

any issues you are Unable to resolve yourself.
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Logout

How to logout

e Tap = Icon on My Profile screen

e Llogout

Note: For security reasons, the DSG will automatically log you out after 7 days of being logged in.
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How to Best Make Use of DSG

Core Sections of the User Journey

The DSG app is not a linear-flow user experience journey, but, there is a preferred journey route with

core features, so the users and the Guests can make best use of the app.

Login to the app

The Showroom section to select a vehicle of interest

The Model Selection section to select a package / series of interest

The Explore section to explore 360 view of the the vehicle of interest

The Model Compare section to compare the vehicle of interest against all available models,

also a good opportunity for upsell

The Competition Comparison to compare the vehicle of interest against competition
models.

The Configure section to create Guest and configurations for the vehicle of interest in depth
because at this point the Guest is pretty sure of the vehicle they want to purchase

The Price Estimate to share the Price Quote with Guest.

Loan Calculator to calculate monthly payment.

Tools->Smart Drive Audio section to create a personalized driving experience for the Guest
Tools-> Brochure section to share brochure with Guest

Guest Section to Create New Guest, Search Existing Guest Profile, add Sales Note and

Communication logs.

A snapshot of each core feature’s key screen is provided below as reference.
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Showroom Section

10:43 AM  Mon 3 Nov

Showroom Bakkies

Bakkies

Ford Ranger
R 620,000

> O

Performance

SUVs

Bakkies

Ford Ranger
R 1,270,000

O,
o0
COMPARE

(=5}

o N
)

GUEST /
P

Trucks And Vans

= 93% @l

Vans

<= 93% @)

Cgo Compare With Competitor> CCD Explore 360° View)

=
SHOWROOM TOOLS EXPLORE
Model Selection
10:44 AM Mon 3 Nov
e
Ranger
Filters 3= Engine -~ Series -~ Body Style ~

Platinum 3.0L V6 Diesel...
R1,150,000

O cCompare

Features

~ The right drive mode for ...
v Seamless and smart conn...

+51 More features
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Ranger Tremor 2.0L Bi-T...

R1,008,000

O Compare

Features

v The right drive mode for ...
v Seamless and smart conn...

+50 More features

Ranger Wildtrak 2.0L Bi...
R841,500

O Compare

Features

v 5 Star Safety Rating
v Extra protection in all dire...

+52 More features

Ranger Wild
R841,500

O cCompare
Features

v 5 Star Safet)
~ Extra protec

+52 More featu)
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Explore Section

<@ Model Range Variant Wildtrak

RANGER

Package Comparison and Competition Comparison

10:49 AM Mon 3 Nov = 92% mmm)
e
+ +
Ranger Ranger Add Vehicle Add Vehicle
Ranger Tremor 2.0L.. v Platinum 3.0L V6 Die.. v

R1,008,000 R1,150,000
CAudio And Communication) Available Bodystyles Chassis & Suspension Comfort and Convenience Driv

Audio And Communication ~

AM/FM Stereo Radio
S S

Bluetooth<sup>@</sup> with Phone / Audio Streaming

S S

Colour Multi-Function Touch Screen Display

12" screen 12" screen

Digital Instrument Cluster with Configurable Display

g" 12.4"
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Configure Section

10:47 AM  Mon 3 Nov = 92% (amm)
e
Ranger R1008000.00
Ranger Tremor 2.0L Bi-Turbo Diesel 10AT Full Time 4 Wheel Drive +R1013137.71 accessories

@®eeceeccccccocce >

Color: Frozen White Interior: Premium Fabric

o*® owow SGaddaad

Accessories Ford Protect %
e - View Summary
02 added 01 added

Price Estimate

10:47 AM  Mon 3 Nov = 92% amm)
e
Ranger R1008000.00
Ranger Tremor 2.0L Bi-Turbo Diesel 10AT Full Time 4 Wheel Drive +R1013137.71 accessories
Summary
Color Frozen White
Seat Premium Fabric

Ford Protect
—GERTTN
)

S

R1008000.0

Accessories

Edit Configuration >
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Loan Calculator

= 92% wmm)

Loan Calculator <
Down Payment 202114
—.
o R20,21137.71
Rate of Interest 7.5 %
0 % 30 %
Duration in Months 30 months
O months 60 months

Your monthly EMI

R56,582%*

’

Rate of Interest @7.5%*2 Years

= Down Payment R2,02,000

® Loan Amount R18,19,023

® Interest Amount R2,17,962

Total Amount Payable R20,36,986*

Save Monthly Payment Amount

Tools -> Smart Drive Audio

10:59 AM  Thu 6 Nov = 100% ==

€«

Smart Drive Audio
Bakkies Performance

Ford Ranger G Ford Mustang °

_ AT
a=
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Tools -> Brochure

10:59 AM Thu 6 Nov = 100% (.

Brochure

All Vehicles Bakkies Performance SUVs Trucks And Vans Vans & Buses Vans and Buses

Ranger Ranger Mustang

Everest Puma

-
=

Transit Custom Transit Van

5N

Guest Profile Creation and Search

10:50 AM  Mon 3 Nov v = 91% @=m)

Guest o

Test2 Ravil Ford Ranger - N

8218539022 Ranger Tremor 2.0L Bi-Turbo < View Profile 3
Diesel 10AT Full Time 4 Wheel \__ e
Drive

User Visit: November 03, 2025 Add Sales notes ~

apoorva mishra Ford Ranger B ~

9990554781 Ranger Tremor 2.0L Bi- < View Profile >

Turbo Diesel T0AT Full /

Time 4 Wheel Drive

User Visit: November 03, 2025 Add Sales notes ~
Q, o>
{ =] @ S° - ) View Profile >

SHOWROOM TOoOoLS EXPLORE COMPARE GUEST A
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10:50 AM  Mon 3 Nov = 91% @mm)

(o Guest Journey

Test2 Ravil ®

8218539022 Explore
Feel the 360 experience of your View Now
car
Ford Ranger
Ranger Tremor 2.0L Bi-Turbo Diesel 10AT Full O
Time 4 Wheel Drive Configuration
Configure your car as per your Completed
needs
Guest Info Sales Note Communication Log o
Accessories
Add hint of your style to your Completed
Guest Information Vi =2
Guest Name Last Name O
Test2 Ravil Ford Protect completead
Protect your car with Ford
Mobile Number Email O
8218539022 test@gmail.com Bill Estimate
Estimate bill of your configured Completed
car
Purchase Timeline Interested Vehicle
October 31, 2025 Ford Ranger
Souvenir

A memento for you from us car

Guest Signature
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How to Create Quick Guest Profile

At the early stage of the sales journey, Guest information can be captured to create a quick Guest profile
with their basic information in following 2 ways:
1. Select Nameplate from Showroom Screen, Select Model and click on Configure button, At this
stage Guest Information capture screen will open, if guest is not intrested insharing information at
this stage it can be skipped and SC can continue the journey to next screen Configure Screen
2. Click on Guest icon on Navigation Tool Bar at Bottom, on Guest Screen click Add New Guest
3. Note : Before creating Guest always search the Guest with their mobile number so if :
a) Guest already exist then the details will be auto populated
b) Guest with same Mobile number, Nameplate and Model already exist at this dealer his existing lead
will open for continuing the journey
c) Guest with same Mobile number same Nameplate and same Model not found on this dealer
then new Guest Lead will be created.
It can be edited by clicking on Viwe profile on Guest screen and clicking on edit icon
e Step 1: Tap on the Guest information edit icon
e Step 2: Update the basic information
e Step 3: Tap on Signature button, signature sign modal displays
® Step4: Get Guest to signin the signature section; Guest signature can be cleared and re-signed
until they are satisfied

e Step 5: Tap on the Update button to save the changes
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Note: The Guest Information fields are market variable shall vary market to market.

10:50 AM  Mon 3 Nov = 91% @m)

S Guest Journey

Test2 Ravil ®
8218539022 Explore

Feel the 360 experience of your View Now
car

Ford Ranger
Ranger Tremor 2.0L Bi-Turbo Diesel 10AT Full O
Time 4 Wheel Drive

Guest Info Sales Note Communication Log O

Configuration
Configure your car as per your Completed

needs

Accessories
Add hint of your style to your Completed

Guest Information V4 =
Guest Name Last Name
Test2 Ravil Ford Protect Completed

Protect your car with Ford

Mobile Number Email

8218539022 test@gmail.com Bill Estimate
Estimate bill of your configured Completed
car

Purchase Timeline Interested Vehicle

October 31, 2025 Ford Ranger

Souvenir
A memento for you from us car

Guest Signature
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Navigation Toolbar

Accessible from all main screens, the Navigation Toolbar provides entry points to all key sections.

What does it do

10:43 AM  Mon 3 Nov = 93% amm)

Show room All Vehicles Bakkies Performance SUVs Trucks And Vans Vans i

Bakkies Bakkies
Ford Ranger ° Ford Ranger
R 620,000 R 1,270,000

= © e 8o &

SHOWROOM ToOLS EXPLORE COMPARE GUEST

On the bottom, a shortcut of key features is listed, providing constant and quick navigations from any
stage of the sales journey.
Note: The Guest shortcut icom is inactive in Guest Mode so the Customer cannot see the deatils of other
Guests.
On the panel:

e Showroom button

o Quick access to Showroom section
e Tools button

o Quick access to Tools section

Ford Guest Experience Digital Sales Guide | User Manual | March 2023 Page 20



e Explore button

o Quick access to Explore 360 section
e Compare button

o Quick access to Competition Comparison section
e Guest button

o Quick access to Guest section

Showroom

After successful login into the app, the landing screen is in the Showroom section.

What does it do

10:43 AM  Mon 3 Nov = 93% @)

Show room All Vehicles Bakkies Performance SUVs Trucks And Vans Vans {

Bakkies Bakkies
Ford Ranger ° Ford Ranger
R 620,000 R 1,270,000

- ©) e 8o &=

SHOWROOM ToOLS EXPLORE COMPARE GUEST

In Showroom section, users can:
a. Change the postcode; dependent on this postcode, the drive away price of the vehicles will be
reflected (Available in selected markets)
b. View features of the vehicle of choice from the Gallery

c. Swipe left/ right to make a selection of vehicle of Guest's interest
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d. Tap on Explore to enter Explore 360 sections

e. Tapon any of the vehicle type button, i.e. Cars, Commercial, Performance, SUV to view/ select
a vehicle of interest from specific vehicle categories

f. View all the vehicles available for the nameplate selected

g. View and filter Offers available (Available in selected markets)

h. Tapping on a vehicle hero image to make it active and enter the Model / Package Selection section

How does it work

Select and Explore a Vehicle of Interest

e Step 1: Take the following options to select a vehicle of interest:

o Tappingon left/right arrow icons to swipe left/ right, or:

o Tap on any of the vehicle type name, i.e. Cars, Commercial, Performance, SUV the
categories displayed is market variable), all vehicles available in the selected category
will be displayed, or:

o Tapon All Vehicles, all vehicles available will be displayed

e Step 2: then tap on a vehicle hero image to make it a vehicle of interest and enter the Model

/Package Selection section directly.
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Model / Pacakge Selection Section

7:30 3l S @,
e
7:32 szl = @)

Features of

< Platinum 3.0L V6 Diesel 10AT Full Time 4 Wheel

s — Drive
Ranger <8°> CCDD
Smart
Filters == Engine - Series -~ Body

RNDM

The right drive mode for every Seamless and s
Platinum 3.0L V6 Diesel 10AT Full [J] Compare
Time 4 Wheel Drive
R1,150,000 safety

Features

~ The right drive mode for every surface
~ Seamless and smart connectivity

+51 More features

Configure

5 Star Safety Rating Extra protectiol

Capability

e Step 1: tapping on the 51+ Features button at each Model Section will show
All available features of the vehicle.

e Step 2:tapping on Back icon to close/ exit All features view
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731 12 = =

Capability

An engine that can tackle anything Tow with unwa

Technology

Ready to tackle anything Tow and haul o

Quality

Coast-to-Coast Instrumental Panel Autonomous er

Redefining Efficiency A Smarter Way

Performance

Platinum Grille Unique Wheels

*The screenshot is for reference only and elements are market dependent
e Step 3: Tapping on a feature image to go to open feature details view
e Step 5: If multiple features are available, swipe downward / upward to view different categories and
left / right to see different features in that category.

e Step 7: Tapping on Back icon to close/ exit full screen view
e Step 8: Tapping on Xicon to close/ exit feature details view

Navigate to Other Sections

e Navigation to Explore 360 by tapping on Explore 360 icon on top right left to Competition Comparison,

e Navigation to Competition Coparison by tapping on Competition Coparison icon on top right corner

. Navigation to Model / Package Comparison by tapping on Compare on each Model Card, you can add
upto 4 Models for comparison in iPad / Tablet and 2 in Mobile device

e Navigation to Configure sections can be achieved by tapping on the Configure button
Explore
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What does it do

The Explore section can be accessed from the navigation toolbar at the bottom of the Showroom
screen or from Model Selection Screen on top right corner.
Ideally, the user would take a tour in the Showroom and select a vehicle of interest for further

exploration if not the same can be selected from explore screen.

10:43 AM  Mon 3 Nov = 93% amm)

Showroom All Vehicles Bakkies Performance SUVs Trucks And Vans Vans

Bakkies Bakkies
Ford Ranger ° Ford Ranger
R 620,000 R 1,270,000

= © e 8o &

SHOWROOM TOOLS EXPLORE COMPARE GUEST
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@D Model Range Variant Wildtrak €3

RANGER

*The screenshot is for reference only and elements are market dependent

From the Explore, users can:

e Switch between models to explore 360 view for them(Not All Nameplates and their Models would be available
for 360 Degree Explore)

e Go Back to previous screen

e Explore the vehicle features in details:
o Rotate vehicle around for 360 view by moving the hand cursor left and right
o Explore Exterior and Interior view by clicking on Exterior and Interior button
o Explore different colors by selecting one from the available options

o Explore different features by clicking on Hotspots, each hotspot on click will show the image
and description of that feature.

o Explore 3D Vehicle Interaction by like Open / Close Doors etc (Jan 2026)
o Explore AR View (Jan 2026)

o Explore Vehicle information using Ford Al Chat (Jan 2026)
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How does it work

Switch Modes

In the Explore section, there are 3 view modes available:

If view modes are not applicable to the models, they will be in disabled/ inactive status.

e 3D and AR view: view vehicle in 3D and AR mode
e Exterior / Interior View: Switch between Exterior and Interior view of the vehicle

e Hotspots: Turn on hotspots on the vehicle

Configure

The Configure section is accessible through Selection on Nameplate from Showrrom screen followed by Model
Selection and clicking on Configure button on specific Model whcih Guest wants to purchase.

10:44 AM  Mon 3 Nov = 93% emm)
%
Ra nger (80 Compare With Competitcr> CCD Explore 360¢ View>
Filters == Engine -~ Series -~ Body Style -~
% ﬁ giﬁ‘@. E‘K
Platinum 3.0L V6 Diesel... Ranger Tremor 2.0L Bi-T... Ranger Wildtrak 2.0L Bi... Ranger Wild-
R1,150,000 R1,008,000 R841,500 R841,500
[J compare [J cCompare [J Compare [J cCompare
Features Features Features Features
v The right drive mode for ... ~ The right drive mode for ... + 5 Star Safety Rating ~ 5 Star Safety
v Seamless and smart conn... v Seamless and smart conn... v Extra protection in all dire... ~ Extra protec
+51 More features +50 More features +52 More features +52 More featul

What does it do
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10:47 AM  Mon 3 Nov = 92% (mm)

<«

Ranger R1008000.00

Ranger Tremor 2.0L Bi-Turbo Diesel 10AT Full Time 4 Wheel Drive +R1013137.71 accessories

@ eeececcccccococec >

Color: Frozen White Interior: Premium Fabric

ooveoow GEdaaa
Accessories Ford Protect a
= + View Summary
02 added 01 added

*The screenshot is for reference only and elements are market dependent

From the Configure section, users can:
e Select Package/ Model and go to Model Compare section
e View MSRP price of the vehicle, this is dynamic content in line with the vehicle selected
o View the Summary of the configuration
e Configure vehicle by category (g):
o Trim

o Paint

How does it work

Change configuration models/packages

The active sales lead, i.e. the vehicle selected from the Showroom section is the one displayed on the

Configure section.
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The user can view and change models for configuration by selecting the desired model and clicking on configure
from Model Selection Screen:

Configure Models

The user can configure the vehicle by the following categories in the Configure section to help the Guest

create their desired vehicle:

e Color/ Paint

e Trim

Configure Color / Paint

e Tap onthe Color radio button at the bottom left-hand side of the screen

e All available Color options will be displayed next to it

e Tapping on a Color option, the vehicle color and background color will change accordingly

e Ifthe color configuration requires additional cost, the MSRP price on top will be updated
automatically to include the additional cost

Configure Trim

e Taponthe Trim button at the bottom right

e All available trim configurations will be displayed next to it

e Tapping on the selection icon on a trim option selects it

e If the trim configuration requires additional cost, the MSRP price on top will be updated

automatically to include the additional cost

Configuration Summary

Once the Guest is satisfied with their configuration, tap on the Summary button from Configure screen:
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All configurations the Guest selected are saved and displayed on the Summary screen.

10:47 AM Mon 3 Nov = 92% @)
e
Ranger R1008000.00
Ranger Tremor 2.0L Bi-Turbo Diesel 10AT Full Time 4 Wheel Drive +R1013137.71 accessories
Summary
Color Frozen White
Seat Premium Fabric

Ford Protect

R TTNN
| )

R1008000.0

Accessories

—— |
( Edit Configuration> View Bill Estimate

From the Summary screen, the user can:

e Edit configuration: tapping on the Edit Configuration button, directs back to Configure screen

e Goto View Price Estimate

Model Compare

In the DSG, the user can take the Guest through the model Compare section to view all the available

models under the same nameplate.

The goal is to help the Guest find the most suitable model to their needs and use it as a good upsell

opportunity.
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What does it do

Select Nameplate from Showroom Screen, all the available models will be shown, on each model
Compare Selection icon is there, by selecting / deselecting it, you can add / remove the models from
comparison, in the model Compare section, users can:

e Filter differences among models

e Expand/ Collapse sections

e Return to the Model Selection Screen

e Change models

e Add new models (maximum 4 models can be added for comparison on iPad/Tablet and 2 on Mobile)

e Expand/ collapse feature view mode per section
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10:49 AM Mon 3 Nov <= 92% wmm)

e
+ -
Ranger Ranger Add Vehicle Add Vehicle
Ranger Tremor 2.0L .. w~ Platinum 3.0L V6 Die.. wv
R1,008,000 R1,150,000
CAudio And Communication) Available Bodystyles Chassis & Suspension Comfort and Convenience Driv
Audio And Communication ~

AM/FM Stereo Radio

S S

Bluetooth<sup>®</sup> with Phone / Audio Streaming

S S

Colour Multi-Function Touch Screen Display

12" screen 12" screen
Digital Instrument Cluster with Configurable Display
8" 12.4"

How does it work

Manage models for comparison

Add or Change models for comparison

If the Guest wishes to change the models selected for comparison, it can be done via:
e Step 1: Click on Add Vehicle + button to select new model for comparison, the result will

be updated on the screen

e Step 2: Tapping on the X button icon on the top right corner of the vehicle, directing to Add

Vehicle Section
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Compare models

Once the Guest is satisfied with the models selected for comparison, they can review the comparison

results on the model Compare screen.

The user can view the results by:
e Show Differences: this will display only the differences among the models selected
against the active model, allowing the Guest to make quick judgements.
o Tapping on the Show Differences Only toggle to enable/ disable the view options
e Expand / Collapse Sections: this will expand the collapsed sections to allow for a complete
view, allowing the Guest to have a comprehensive comparison
o TappingontheV/”icon to expand / collapse the sections

e Select specific section: this allows the Guest to view details section by section of their choices.
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o Tapping onthe downward arrow button at the end of each section title to expand the

section content

o Oncethe content of the section is expanded, tapping on the upward arrow button to

collapseit

Note: when in expansion mode, the user needs to scroll the screen up to see more content than

displayed in view.

Tools

From Tools panel, below can be accessed:

e Brochures
e Smart Drive Audio

e Souvenir (Phase 2: Jan 2026)

en am

Brochure Smart Drive Audio

= o @ So =2,

SHOWROOM TOoOLS EXPLORE COMPARE GUEST
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Brochure

e Click on Tools from the navigation Tool Bar at bottom, on tools screen tap on the Brochure button

e Tap on the card with vehicle thumbnail image for which you want to open the brochure to view the
brochure pdf or

e To share the brochure tap on share button on the card and all the share options will show

10:59 AM Thu 6 Nov = 100% =
Brochure
Bakkies Performance SUVs Trucks And Vans Vans & Buses Vans and Buses
Ranger @ Ranger @ Mustang @
Everest @ Puma <o> Territory <o>
Transit Custom Transit Van Tourneo Custom

\ . i 2 \ %N
- A-‘ - E\k‘- -i ai?-.-

Smart Drive Audio

The Smart Drive Audio journey can be accessed in the following way:

e Click on Tools on the Navigation Toolbar at bottom then click Smart Drive Audio

Smart Drive Audio can also be used for education and training for the SC to learn about specific features

of Vehicles.

The Smart Drive Audio section contains a list of audio tracks for certain features of the vehicle

selected.

While the Guest is driving, the user can connect his device to the vehicle via Bluetooth and play the
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audio tracks via the Smart Drive Audio.

1060 AM  Tha 6 MNow

<

Smart Drive Audio

< AlL Vehicles ) Bakkies Performance

Ford Ranger Ford Mustang

11:00 AM Thu 6 Nov = 100% ==
Audio Settings

Platinum 3.0L V6 Diesel 10AT Full Time 4 Wheel Drive test1233 'Ill”' >

test1233

42 C)

«Q »

How does it work

e Click on Tools on the Navigation Toolbar available at the bottom then click Smart Drive Audio
on Tools Screen.

e Select the Vehicle and its package for which you want to see the audio tracks

e Taponthe playicon to play the desired track(s)

e Tap on Backicon to go on previous screenand exit the Smart Drive Audio

o Access the list of audios across all nameplates
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My Profile

e My Profile can be accesed by clicking the my profile icon from top right corner of the screen

o My profile screen is mainly view only, the user can:
o Check his details in My Details section

o Check for App information

o  Switch Language and Countries from available options as applicable

e Exit the screen by tapping on the back buttonicon

9:49 U T e ) 9:45
e
Showroom N
@ My Profile Profile
& Guest Mode (> 2
My Details
Bakkies
(= Logout

User Name

Ford Ranger
R 620,000 o E-mail Address

Dealer Code

Dealer Name

Bakkies App Version

Version Code

Ford Ranger
R 1,270,000

=
= © @ 8o &

SHOWROOM TOOLS EXPLORE COMPARE GUEST //I

App Information

d))

South Africa 2~ English

Test User DSG

T-DSG@b2bford.com

90208

Ford Dealer

1.0.0
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Guest Section
Search Existing Guest

e From the Navigation bar at bottom click on Guest to open Guest Section, tap on the Search
Bar on top.
e Typeinthe the exact number

e Ifthe number is not an exact match, noresult will be presented

e If matching results found, they will be displayed under the search content

10:50 AM  Mon 3 Nov 1 = 91% @)

(7

Guest Q Search + Add New Guest
Test2 Ravil Ford Ranger
8218539022 \ Ranger Tremor 2.0L Bi-Turbo View Profile
Diesel 10AT Full Time 4 Wheel
Drive
User Visit: November 03, 2025 Add Sales notes v
apoorva mishra Ford Ranger

9990554781 \ Ranger Tremor 2.0L Bi- View Profile
Turbo Diesel 10AT Full

Time 4 Wheel Drive

User Visit: November 03, 2025 Add Sales notes v

Tr
=) © e8o .

SHOWROOM TOOLS EXPLORE COMPARE GUEST

View Profile
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Guest Profile

What does it do

6:12

Guest

Q 9999912345

aH

No Guest Found

@ -

EXPLORE COMPARE

= (O

SHOWROOM TooLs

Clear

o
-

GUEST

Accessible from the the navigation toolbar at the bottom. On the Guest screen all the guest leads

will show, by clicking View Profile the Guest profile will open
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10:50 AM  Mon 3 Nov

= 91% (@l )

& Guest Journey
Test2 Ravil ®
8218539022 Explore
Feel the 360 experience of your View Now
car
Ford Ranger
Ranger Tremor 2.0L Bi-Turbo Diesel 10AT Full O
Time 4 Wheel Drive Configuration
Configure your car as per your Completed
needs
Guest Info Sales Note Communication Log O
Accessories
Add hint of your style to your Completed
Guest Information V4 Gl
Guest Name Last Name O
Test2 Ravil o Clotect Completed
Protect your car with Ford
Mobile Number Email O
8218539022 test@gmail.com Bill Estimate
Estimate bill of your configured M
car
Purchase Timeline Interested Vehicle

October 31, 2025 Ford Ranger

Souvenir
A memento for you from us car

Guest Signature

e View the Guest Info, Vehicle details, Sales Note, Communication log and Guest Journey
e Share Information: Vehicle Details, Price Estimate, Brochure and Souvenir to Guest through email.
e Guest Journey with Quick Access to the following items
o Explore 360
o Vehicle Configuration Details
o Price Estimate
o Souvenir
® Manage Sales Notes
e Manage Communication Logs

e Manage Guest profile
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How does it work

Manage Guest profile

This is optional. Guest information collected along the journey prior to this step has been saved
against the Guest profile and displayed in the Guest profile.
e From here, the user can edit/ update/ complete the Guest profile fields

e Once satisfied, tapping on the Update Guest button to save the changes made.

Manage Available Leads

The active lead (Not older than 3 months) is available in Guest Section.
In DSG Application there can be only one lead that can exist with same mobile number same package at

Dealership.

Always try to search if the lead for the guest already exist, if yes then work on the existing Guest lead, if no
Guest Lead found with the mobile number create a new lead.

Manage Sales Notes

Sales Notes located below the vehicle details on the Guest Profile Screen, left to Communication
Log. Sales Notes allows you to add notes and Guest requirements for yourself or other SCs to see the

next time the Guest Profile is retrieved.

Create a new Sales Note

e Step1:Tap 6. to create a new Sales Note.

e Step 2: Fill in the title of the note.

e Step 3:input the notes.

e Step 4: Tap Save Note button to save the note; tap X to cancel without saving.
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Add New Sales Note <

Add your Title*

Add your Sales Note*

O / 150 characters

Manage Communication Log

Communications Log locates belwow Vehicle Details on the Guest Profile screen, right to Sales Notes

column, where you can record communications sent to the Guest for convenient referencing the next

time the Guest Profile is retrieved.
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New Communication Log

Log’'s Date

Date*

Communication Type*

Email Call Walk-In

Sales Notes

Add your Sales Note*

Social

O /150 characters

Create a new Communication Log

e Step1:Tap £ to create a new Communication Log.
e Step 2:Fill in the title and description of the log.

e Step 3: Select the communication type

e Step 4: Tap Save Log button to save the log or tap Xto cancel without saving.
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Share Information to the Guest

e Step 1: Tap ‘Share Info’ button on the Guest Profile screen, directing to the Send Info

screen for item selection.
e Step 2 Select / the item (or multiple items) to be sent to Guest.

e Step 3: Click on Share with Guest to send selected items to Guest over email.

7:28

= @)

e

8218539022

Vehicle Details

Share Info <

Ford Ranger

Ranger Tremor 2.0L Bi-Turbo Diesel 10AT Full Vehicle Brochure
Time 4 Wheel Drive

User Visit:

Guest Journey
@®

Explore View Now

Feel the 360 experience of your car

Configuration

Configure your car as per your View Now
needs

Share with user
Bill Estimate

Estimate bill of your configured car

View Now
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Competitive Comparison

The user can help the Guest to conduct a comparison between the Ford vehicles with other brands in

the DSG.

What does it do

Accessible by clicking Compare icon on the navigation toolbar at the bottom, users can:

e View the comparison results by filtering the Ford advantages and view all the comparison results

e Exit the section by tapping on the back icon and return to previous step

e Select Brand and Models

e Expand/ collapse view comparison results by section

9:01

)

P

Choose Ford Ranger

that suits your Style

" o=s +
Ford Ranger Add Vehicle

Platinum 3.0L V6 Diese... ~~

R1,150,000

Interior features

Interior features

Bedliner w/ 12v Socket

N

TFT 127 Full LCD Instrument Cluster

Auxillary 12V Power Outlet - Centre Console

Y

%.2" Dual TFT Instrument Cluster

N
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9)

e

Choose Ford Ranger

that suits your Style

Ford Ranger Toyota Land Cruiser Prado

Platinum 3.0L V6 Diese... ~~ 2.8L GD TX AT Dsl ~

R1,150,000

Clnterior features)

Interior features ~

Bedliner w/ 12v Socket
N

TFT 12" Full LCD Instrument Cluster

Auxillary 12V Power Outlet - Centre Console

b ¢

4.2" Dual TFT Instrument Cluster

N
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How does it work

This section works in a similar fashion as it does in the PackageCompare section.

Select/ Deselect vehicles/ brands for comparison

e Step 1: Tap on the Add Vehicle + button and select Ford models and competitor brands
e Step 2: Tap the Xicon to remove any selected Model to change brands selected, Add another

Vehicle

e Step 3: Tap on the Add a Vehicle to Compare to add a selection;

View comparison results
e Tapping on Show Ford Advantages to view all advantages Ford vehicle has over the selected

brands;

e Tapping onthe v/~ icon to view and collapse detailed content per section

Guest Mode

Accessible from the top right corner section, the Guest Mode allows Guests to explore on their own, if

they wish to be left alone.
e Tapping orTurning on the Guest Mode button

® When the Guest finishes their exploration, tapping on the Guest Mode to exit Guest Mode
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e Guest Mode, the experience will be limited
o Access the Showroom section
o Access the Explore section
o Access the Configure section
o Access model Compare Section
o Access Tools Section

o Not Accessible Guest Section

)
'

5:24

Showroom
@ My Profile

AlL Vehicles Comn H
&2 Guest Mode O

Commercial
— Logout

Ford Everest o
4 1,099,000,000

Commercial Vehicles

Ford Ranger °
d 864,000,000

E—3 [ e So =2

SHOWROOM TOOoLS EXPLORE COMPARE GUEST
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Offline Mode
The DSG Application will not work in Offline Mode.

FAQ

Q1: What can | do if the app fails to download?

e This sounds like an internet problem, please double check your WiFi signal and make sure you are

connected.

Q2: The app won't open. What's the problem?

o The most common cause is the app is ‘not trusted’ by your iPad, to fix this, follow the steps in the

DSG Installation Guide.

Q83: I'm a sales consultant, why can’t | login?

e You should check that your SPS ID, job role, and password are valid, and that they belong to the

dealership where you are logging in.

e If your SPS ID is valid and the country is correct, please contact your supervisor for further

assistance.

Q4: How can | report a crash?

e We are constantly working to improve the DSG, please report repeated crashes to your supervisor

or on fordcare@girnarsoft.com so we can address the issues.

Q5: Can | install the DSG on an iPhone or an Android device?

® Yes
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® Please make sure you are running the latest version of iOS (15 or later) and Android 10 and above

and you have sufficient space to instal the application.

Qé6: Why can't | retrieve a Guest profile?
e Check your WiFi signal and make sure you are connected to the Internet.
o Double check and make sure you have entered the exact phone number of the Guest; near

matches will not be found, only exact matches

Q7: Can | share my iPad and DSG with another sales consultant?
® You may share your iPad with a colleague but make sure you have successfully logged out of the

DSG first. If not, all new sales leads will be stored against the wrong profile.

Q8: How can | create an Active Vehicle?

e An active vehicle is created automatically by going from Showroom to Explore.
Q9: What if | can't find my question here?

® Please let your manager know and they will get in touch with the relevant teams at Ford to

help you or drop an email at fordcare@girnarsoft.com.

Support

If you have any other questions, please contact your Dealership Manager; they have been instructed to

consult the FGE Dealer team.

Note: Few Sections and module might not be available for use in your Market. This is a standard DSG

User Manual which covers all Section and Modules available in the DSG application.
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